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Preferences

Introduction

This chapter explains the use of the “Preferences...” dialog. The “Preferences...” command
is found under the Edit menu.

BBEdit’s behavior is in part controlled by sets of preferences. You can change these
preferences to suit your own needs or your personal taste.

The Preferences Dialog

To bring up the Preferences dialog, choose “Preferences...” from the Edit menu, or double-
click on your BBEdit Prefs file. (This may not be convenient, since the BBEdit Prefs file
usually resides somewhere within the System Folder.)

The Preferences Dialog looks like this:

Preferences
Preferences | Global bl
(4 Delay when Scrolling At startup:
[<] Show Status Bar i{_) Mothing
[ Show Philip Bar i New Window
[] Show Tab Stops i® Open
<] MPI! Compatible i1 Open Several
[J Show Line Numbers
[<] Show Cursor Position
[] Hide “MPLI*” Menu

The popup menu next to the “Preferences” text determines which section of the
preferences you’'re looking at. If you click on “Save”, all of the preferences settings will be
saved to the “BBEdit Prefs” file. If you click on “Cancel”, the existing preferences will be
left alone, and any changes you’ve made in the Preferences settings will be discarded.
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Global Preferences

These settings (shown above) affect BBEdit’s overall appearance and behavior.

Delay When Scrolling makes BBEdit wait a tenth of a second when you
click in the arrows of a scrollbar before scrolling the text in a document window.
This is most useful under System 6 on faster machines; often several lines will go
by before your reflexes allow you to let go of the mouse button. System 7 offers a
“scrolling throttle”, so this setting may be turned off.

Show Status Bar causes the status bar to be visible within all editing
windows. (See “Editing Text With BBEdit” for a description of the status bar.)
This option is on by default; you can turn it off if you have a small screen and
screen “real estate” is at a premium.

Show Philip Bar draws a vertical gray line in the status bar at the point
where the visible editing area ends on a 9-inch “classic” screen. See the
“Wrapping” section of “Editing Text with BBEdit” for more details. This option is
dimmed if “Show Status Bar” is turned off.

Show Tab Stops places tick marks in the status bar to indicate the position
of tab stops in each editing window. This option is dimmed if “Show Status Bar”
is turned off.

MPW Compatible makes BBEdit emulate some aspects of the MPW Shell’s
behavior. If it’s turned on, 3-A is used for Select All, 38-G for Find Again, 3-H
for Find Selection, #8-] for Go To Line..., and 3-T for Replace and Find Again. If
it’s turned off, these keyboard equivalents become the same as for older versions
of THINK C, with some minor changes: #-A is Find Again, 3-Y is Replace and
Find Again, 38-T is Find In Next File, and #-G is Go To Line...

Show Line Numbers places line numbers along the left edge of each
editing window.

Show Cursor Position places the cursor-position display at the lower left
corner of each editing window; this display shows the position of the insertion
point, or the last-changed end of the selection range.

Hide “MPW” Menu removes the 2] menu from the menu bar. If you're not
using ToolServer, or you don’t know what ToolServer is, you can turn on this

option to save a little space in the menu bar. If you’'re not using System 7, this
menu will be hidden, and “Hide “MPW” Menu” will be disabled.
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The “Startup Action” radio buttons control what BBEdit does when it’s launched by some
means other than double-clicking on a BBEdit document, or by dragging and dropping
some item onto BBEdit itself (under System 7).

« If Nothing is selected, BBEdit will take no action at startup. This is handy if
BBEdit regularly gets launched into the background, or is launched by some
scripting utility which will then start feeding commands to BBEdit directly.

« New Window causes BBEdit to bring up a new untitled window, as if the
“New” command on the File@ menu had been chosen.

« Open causesBBEdit to bring up an “Open...” dialog, as if the “Open...”
command on the File menu had been chosen.

« Open Several causes BBEdit to bring up the “Open Several...” dialog, as if
that command had been chosen.
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Editor Preferences

These preferences control BBEdit’s editing and keyboard behavior.

Preferences

Preferences | Editor -

 Default Font... |  Monace-3
i4 spaces per tab

(<] Auto-Indent

[0 No “Can’t Undo” Alerts

] Exchange Command and Option
] Use Keypad for Cursor Control
[l Smart Quotes

(<] Auto-Balance while Typing

+ The “Default Font” button sets the font which will be used to display the text
in newly created windows, and for documents which have no saved state
information.

« If Auto-Indent is turned on, BBEdit will indent to the start of the preceding
line whenever you type the “Return” key on the keyboard. This is useful for
programmers and for reverse-indenting text. It may be less convenient if you're
using BBEdit for composing prose.

* Ordinarily, actions such as Entab, Detab, Zap Gremlins, and Replace All are not
undoable, and BBEdit will alert you if you are about to perform a non-undoable
action. If you aren’t concerned about being able to undo these actions, and don’t
want BBEdit to alert you, turn on the ‘N0 “Can’t Undo” Alerts’ check box,
and BBEdit will not alert you of these actions.

- Exchange Command and Option reverses the meaning of the
Command and Option keys when used with the left and right arrow keys. See
“Editing Text with BBEdit” for more details.

- 1f Use Keypad for Cursor Control is checked, the keys on the numeric
keypad (on keyboards that have them) will move the cursor. See “Editing Text
With BBEdit” for more details.

« Smart Quotes is used to determine the default value of the Smart Quotes
setting for newly created windows and for documents saved with state
information other than “BBEdit”.

- If Auto-Balance While Typing is turned on, BBEdit will flash matching
parentheses, curly braces, and brackets as you type them.
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Printing Preferences

These settings provide the default print settings for new windows and for documents which
have saved state information other than BBEdit’s.

Preferences

Cancel

Preferences | Printing |

[nefault Font... ] [ Print Page Headers
4 [J Print in Reverse Order

[]Frame Pages
[J Print Full Pathname

EMu:-nac-:-—‘E!
{4 spacez per tab

1 Modification Date
@ Printing Date

These settings correspond to the same settings on the “Options...” dialog which can be
brought up from the Print... dialog.

Search Preferences
These settings provide the defaults for text searching and multi-file searching. The options

in this dialog correspond to their counterparts in the Find... and the Multi-File Search
Options dialog.

Preferences
Preferences | Search -
(] Entire Word [ Start From... ]
] Wrap Around
[J™atch Case ESEntra Developrient BEBEdit 2.5 f:
[ Grep

[] Search All Types

i® Leave Windows Dpen
_» Save Changes To Disk
B & sesn fiveny Bapas

The “Start From...” button sets the default starting directory for Directory Scan multi-file
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searches.
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Filing Preferences

The settings in this part of the Preference dialog control the default settings for the Open...
and Open Several... dialogs. The “Default Saved State” popup menu determines what state
information will be saved by default when you choose “Save As...” for a new window or for
a file with no saved state information. If “Auto-Backup” is checked, a backup will
automatically be made of a file every time it is saved.

Freferences
Preferences | Filing - _
Open... Settings: Default Saved State:
(] Open Read-0Only BBEdit hd |
(<] Projector-Aware . [] Auto-Backup

[ ] Show All Types
(<] LF Translation

State Preferences

These settings control what parts of a file’s saved state are honored whenever a file with
saved state information is opened. In some cases, it may be desirable to ignore one of these
aspects of the saved state. If the “Leave Room for Finder Icons” is checked, BBEdit will
make certain that there’s enough space below and to the right of any window so that icons
on the desktop can be seen when you’re running under MultiFinder or System 7.

Preferences

Cancel

Preferences State il

Honor

Bl Window Position
(< Font Settings

B4 Selection Range
(<] Scrollbar Position

when opening documents
[<] Leave RBoom for Finder lcons
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Wrapping Preferences

These settings are the default settings for the Wrap... dialog.

Preferences

Cancel

Preferences | IWrapping -

Default Wrap Settings:

i® Philip Bar B4 Paragraph Fill
i Window Width

() Character Width:

(4 Selection Only

ToolServer Preferences

Preferences

Cancel

Preferences ToolServer b

Look for ToolServer on:

i® This Machine
7 A Remote Server

ToolServer Location:

Carnpilers MPW ToolServer

This set of preference controls how BBEdit locates the ToolServer application. If you won’t
be using ToolServer, or don’t know what ToolServer is, you can skip this section of the
preferences.

You may find it desirable to use a ToolServer that’s always running on a specific machine
on the network. In this case, click the “A Remote Server” radio button, and click the “Set...”
button to choose the remote ToolServer. Otherwise, click the “This Machine” radio button,
and use the “Set...” button to select the actual ToolServer application that BBEdit will use.
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File Types

This section of the Preferences allows you to modify the list of file creators that appears in
the “File Creator” popup menu of the “Save As..., Options...” dialog box.

Preferences

Cancel

Preferences File Types il

BBEdit Add...
= MPW Shell
THINK €

Fa Macintosh Pascal
THINK Pascal
## TeachText

fhordata

Ereatur:| |[ el ]

To add a new application’s file creator to the list, click the “Add...” button, and choose the
application. To change an application’s creator signature, click on an application name in
the list, enter a new four-letter code in the text field next to “Creator...”, and click the
“Change” button. You can use the “Set...” button to pick an application and enter its
creator code in the text field for you. To remove an application creator from the list, click
on an application name, and click the “Delete” button.

The creators for “BBEdit” and “Generic Text File” are built into BBEdit and cannot be
changed or deleted.

Note: Icons will only be placed next to the built-in application creators that ship with
BBEdit.
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Grep Patterns

This section of the Preferences dialog allows you to modify the list of regular expressions
which appears in the popup menu next to the “Grep” check box in the “Find...” dialog. The
scrolling list box shows the names of the installed patterns. When you click on one, the text
fields below the list will be filled in with its name, search pattern, and replace pattern. You
can change any of these text fields, and click “Change” to replace the selected pattern with
the changed one. You can also enter new information in the text fields and click “Add” to
add a new pattern, or select a pattern and click “Delete” to remove it from the list.

Preferences

Preferences Grep Patterns w

Cancel
Pascal Comment to C Comment 0| Add
C++ Comment to C Comment
Space Runs to Tabs Replang
EEECHCEES:
=
Mame: | |
Search For: | |
Replace With: | |

Note: You can install a pattern with an empty replace pattern, which is useful just for
locating text which matches a particular regular expression.

For more information in Grep, see the “Searching” chapter.



